ZebraLink™
BlackBerry® smartphone
&
Windows Mobile®
Utility

Tutorial & Users Guide
# Table of Contents

Overview ................................................................................................................................................................. 4

Supported Windows Mobile® devices .......................................................................................................................... 4

Supported BlackBerry™ devices .................................................................................................................................. 4

Supported Zebra Printers ........................................................................................................................................... 5

Creating Label Designs ............................................................................................................................................... 6

Printing from a Windows® Mobile device .................................................................................................................. 16

Printer Management from a Windows Mobile device ............................................................................................... 43

Option Settings on a Windows Mobile device ......................................................................................................... 46

Demonstration Applications on a Windows Mobile device ....................................................................................... 48

Storing Label Templates on a Windows Mobile ........................................................................................................ 53

Installing on a Windows Mobile device .................................................................................................................... 54

Printing from a BlackBerry® smartphone .................................................................................................................. 59

Printer Management from a BlackBerry® smartphone ............................................................................................ 75

Option Settings on a BlackBerry® smartphone ....................................................................................................... 78

Demonstration Applications on a BlackBerry® smartphone ...................................................................................... 80

Storing Label Templates on a BlackBerry® smartphone .......................................................................................... 85

Installing on a BlackBerry® smartphone .................................................................................................................. 86

Setting Permissions on a BlackBerry® smartphone ................................................................................................ 89

Technical Support ..................................................................................................................................................... 94
Overview

The ZebraLink™ Smart Phone Utility was designed to demonstrate the types of applications that can be created using the ZebraLink™ Multiplatform Software Development Kit.

Several on-phone application features are demonstrated, these include:

- Discovering and pairing with printers via a Bluetooth or network connection
- Retrieving and displaying a list of document templates, stored either on the phone or on the printer
- Using document templates to generate an on-screen prompting form, to be filled out by the user at print time.
- Using the Smart Phone’s camera to capture and print an image
- Checking printer status
- Printing configuration labels, resetting printers and defaulting settings – and much more!

Supported Windows Mobile® devices

Supported Windows Mobile® devices (using Windows Mobile 5.0 or later, also requires Microsoft® .NET Compact Framework v3.5 or higher)

- Motorola®/Symbol MC70xx
- Motorola/Symbol MC75
- Motorola/Symbol MC9090
- HTC® Touch
- HTC Diamond
- HTC Pure ST6356
- HP® iPAQ® 910 Business Messenger
- Samsung® Jack

Supported BlackBerry™ devices

Supported BlackBerry smartphone devices (using OS 4.2.1 or later)

- 8100 Pearl™ Series
- Pearl™ Flip Series
- Curve™ 8300, 8520, 8900 Series
- 8800 Series
- Bold™ 9000
- Tour™ 9630

Note: If your device does not have the minimum Operating System noted above, consult your Administrator to have your device updated. The BlackBerry® Desktop Manager can be used to update the Operating System software for your device; however, this should be done in consultation with your system Administrator.
Supported Zebra Printers

- Mobile - MZ™, QL Plus™, RW™ series, P4T™/RP4T™
- Desktop - G-Series™, HC100™, TLP/LP 2824 Plus™
- High-Performance/Midrange - Xi4™ and XiIIIPlus™, PAX4™ series, ZM400™/ZM600™, S4M™, 105SL™
- RFID - RXi™, R110PAX4™, RZ400™/RZ600™
- Kiosk - KR403™
Creating Label Designs

Using the ZebraLink Smart Phone Utility and the free ZebraDesigner™ label design application it’s easy to create, and deploy application specific labeling solutions that can be printed using a Smart Phone.

There are three steps to get started –

- **Designing a label**
- **Exporting the label**
- **Printing from your Smart Phone using the ZebraLink Smart Phone Utility**

**Note:** if you have not yet installed the Utility on your device, see the section “Installing the ZebraLink Smart Phone Utility” later in this document.

**Designing a Label**

The example shown here creates a label using both fixed and variable fields.

First, install the ZebraDesigner™ (or ZebraDesigner Pro™) label design software. During the installation, you will be requested to install a printer driver – choose a driver that matches the printer model you’ll be printing to. See the ZebraDesigner User Guide for more information on installing the software.

Once the label design software and drive are installed run the software. The package will display the “Welcome Wizard”.


1. Click the “Create a new label” radio button, and then click “Finish”:

![Image of the New Label Wizard]

2. Choose the printer you want to create a label for and click “Finish”:

![Image of the Label Setup Wizard]

You can change the printer specific settings by clicking the 'Properties' button.
3. Click “Next” to define the label size. Click “Next” to move through the “Page Size” and “Select Stock” dialogs. You should not have to make any changes on these dialogs.

4. Click “Next” to move through the “Label Layout” dialog.
5. On the “Label Dimensions” dialog, change the “Label Height” to 3 (or the equivalent if you are using a different Unit of Measure). Click “Finish” to accept the new label design.

6. A new blank label format will display:
7. Click on the “Text” tool and choose “New Keyboard Input” – and then click on the label design area:

8. The “Keyboard Input” Wizard dialog will appear. Enter “First Name” for the Prompt and click the “Finish” button:
9. The new field will display on the label. Click on the field to position it in the desired location:

10. Repeat these steps to create a second “Keyboard Input” field, with the prompt being “Last Name”
11. Place this second field on the label:

![ZebraDesigner](image)

12. Click on the “Text” tool and then on the label to create a static – or fixed field. Type the name “Acme Industries” in the text entry box. Click “Finish” when done:

![Text Wizard](image)
13. Place and center the field on the label.

14. Click on the “Line” tool and create a horizontal line across the label.
15. Click on the “Bar Code” tool and choose “New Keyboard Input” – and then click on the label design area. The “Keyboard Input” Wizard dialog will appear. Enter “Department” for the Prompt and click the “Finish” button:

![Bar Code Wizard](image)

16. Place the field on the label.

![Place the field on the label](image)
17. The label design is now complete. Click File>Save to save the label- name it “Example” For purposes of this Tutorial, use the name “Example” - in practice you can use any ASCII based 8 character name

**Exporting the Label**

1. Now the template can be exported to the printer. Click File>Export to printer. The “Select Export Method” screen will display. Select “Internal Flash” and click “OK”. The label Template will be exported to the printer and stored in Flash memory.
Printing from a Windows® Mobile device

Printing the “Example” label design from your Windows® Mobile device is easy.

There are three steps –

- Connect to the printer via Bluetooth, network or serial connection
- Retrieve the label design you want to print
- Fill in the Keyboard Prompts and click the “Print” button

Note: if you have not yet installed the ZebraLink SmartPhone Utility, see the section “Installing the ZebraLink SmartPhone Utility” later in this document.

Discovering and connecting to a printer

Printers can be discovered and communicated with via Bluetooth or network connection. There are several methods available, including:

- Automatically locating printers via a Bluetooth connection
- Manually Connecting to printers via Bluetooth
- Using “Scan and Pair” via Bluetooth (only supported with Motorola® terminals via Bluetooth)
- Automatically locating printers on a Network connection
- Manually connecting to a printer via a Network connection
- Connecting to a previously known device

Click the “Find Printers” icon to begin the process:
Automatically locating printers via a Bluetooth connection

1. To automatically connect to a printer via Bluetooth, it is necessary for the Utility to search the local environment for Bluetooth devices. To use this method, double click the “Bluetooth Auto” button
2. Once the search is complete, a list of discovered devices will be displayed by their Bluetooth Friendly name and MAC addresses.

![Find Printers](image)

**Discovered Printers:**
- 0026FF804B7B (BlackBerry 8320)
- 087C303F9424 (BlackBerry 9700)
- 0022A91BAF25 (LG LOTUS Foobe)
- 00037A4CF2CB (XXXX09-10-5799)
- 0022580106B9 (XXXX09-23-5604)

**Note:** If the Utility determines that the Bluetooth radio is off, you will be notified and asked to allow the radio to be turned on.

3. If your printer was discovered, it will be listed in the search results. If you do not know the Bluetooth MAC address of your printer, print the configuration page of the printer. The Bluetooth MAC address will be displayed in the “Bluetooth” section of the printer’s configuration label. For information on how to cause the configuration label to print, consult the printers User Guide.
4. To create a connection to your printer, double click on the address of the device you want to connect to.

5. The Utility will create a connection to the printer and query the printer to determine the printers formatting language:

6. Once the language has been determined, the name of the language will be displayed on-screen and the Utility will return to the home screen, showing a connection to the entered address.

   The printer may now be used from the Utility.
Using *Scan and Pair* to connect via a Bluetooth connection

**Note:** The “Scan and Pair” feature is only possible when using a Motorola terminal and when the “Friendly Name” of the printer has been configured. Zebra Mobile printers come with the “Friendly Name” preconfigured to the Serial Number of the printer.

1. To connect to a printer via Bluetooth using “Scan and Pair”, it is necessary for the Utility to first use the barcode scanner to scan the barcode label on the Mobile printer that contains the printers “Friendly Name”. Once that is done, the Utility will search the local environment for Bluetooth devices using the scanned “Friendly Name”.

2. To use this method, double click the “Scan and Pair” button
3. The scanner app (or camera app) on the terminal will display. Position the scan (or camera) application so that it can scan the “S/N” barcode on the Mobile printer. Trigger the scanner (or camera) app to scan the barcode. For example, the image below shows a MZ 320, which would have shipped with the “Friendly Name” set to “XXX09-10-5799” – which is also the Serial Number of the unit.

![Barcode Image]

*Note:* The “Scan and Pair” feature requires that the scanner in use has a barcode scanner and has been configured for scanning.

4. Once the scan is complete; the name of the device to connect to is shared with the Zebra Utility. The Utility will then scan the local environment for a device that is using the indicated “Friendly Name.” Once the device is found, the Zebra Utility will make a connection to the device.

*Note:* If the Utility determines that the Bluetooth radio is off, you will be notified and asked to allow the radio to be turned on.
5. The Utility will query the printer to determine the printer's formatting language:

6. Once the language has been determined, the name of the language will be displayed on-screen and the Utility will return to the home screen, showing a connection to the entered address.

   The printer may now be used from the Utility.
Manually connecting to printers via Bluetooth

1. To manually connect to a printer via Bluetooth, it is necessary to enter the Bluetooth MAC address of the printer. To obtain the Bluetooth MAC address, print the configuration page of the printer. The Bluetooth MAC address will be displayed in the “Bluetooth” section of the printer’s configuration label. For information on how to cause the configuration label to print, consult the printers User Guide.

   A Bluetooth MAC address will consist of 12 Hexadecimal characters, normally represented on the printers configuration label in the following format:

   00:03:7A:18:CA:48

2. Select “Bluetooth Manual” and click “Connect”
3. Select “Bluetooth” and enter the printer’s Bluetooth MAC address. When entering the address, type in the Hexadecimal characters without the colon characters –

00037a4cf2db

4. When done entering the Bluetooth MAC Address of the printer, click “Connect”:

![Image of Bluetooth connection interface]

**Note:** If the Utility determines that the Bluetooth radio is off, you will be notified and asked to allow the radio to be turned on.
5. The Utility will create a connection to the printer and query the printer to determine the printers formatting language:

6. Once the language has been determined, the name of the language will be displayed on-screen and the Utility will return to the home screen, showing a connection to the entered address. The address that the Utility is connected to will also be shown on the screen.

The printer may now be used from the Utility.
Automatically locating printers on a Network connection

The Utility and SDK support more than one method for Discovering printers on a Network. The supported methods are:

- Multicast
- Directed Broadcast
- Local Broadcast
- Subnet search

Multiple methods are offered because Networks will vary, depending on how they are configured, to allow the use all - or in some cases – just one of these methods. Consult your network administrator for details on what your network supports.

Discovering Printers using Multicast

1. Double click the “Network Auto” button

   ![Image of ZebraLink™ Utility interface with Network Auto button highlighted]

   **NOTE:** The discovery methods use UDP-based communications, over port 4201, to locate printers. If your network does not allow UDP communications over port 4201, the automatic discovery methods will not work.
2. Select the “Multicast” method and the number of “Hops” to use. The “Hops” setting controls how many segments of your network the Utility will attempt to search across.

3. Click “Discover” to start the search.

4. Once the Search is complete, a list of discovered devices will be displayed. Select the desired device and click it to select it. The Utility will then begin the process of making a connection to the device.

5. The Utility will create a connection to the printer and query the printer to determine the printer's formatting language:
6. Once the language has been determined, the name of the language will be displayed on-screen and the Utility will return to the home screen, showing a connection to the entered address. The address that the Utility is connected to will also be shown on the screen.

The printer may now be used from the Utility.
Discovering Printers using a Directed Broadcast

1. Select the “Directed Broadcast” method and the range to search. For example, if you want the 10.3.5. subnet searched, enter “10.3.5.255” – this will cause the Utility to send a broadcast message to all addresses in the indicated subnet.

2. Click “Discover” to start the search

3. Once the Search is complete, a list of discovered devices will be displayed. Select the desired device and click it to select it. The Utility will then begin the process of making a connection to the device.
4. The Utility will create a connection to the printer and query the printer to determine the printer's formatting language:

5. Once the language has been determined, the name of the language will be displayed on-screen and the Utility will return to the home screen, showing a connection to the entered address. The address that the Utility is connected to will also be shown on the screen.

6. The printer may now be used from the Utility.
Discovering Printers using a Local Broadcast

1. Select the “Local Broadcast” method and then click “Discover. In this search method, the Utility will search the subnet the device is a part of. For example, if the device you are running the Utility on is in the 10.3.4 subnet, then that is the subnet the Utility will search (and no others).

2. Click “Discover” to start the search

3. Once the Search is complete, a list of discovered devices will be displayed. Select the desired device and click it to select it. The Utility will then begin the process of making a connection to the device.
4. The Utility will create a connection to the printer and query the printer to determine the printers formatting language:

5. Once the language has been determined, the name of the language will be displayed on-screen and the Utility will return to the home screen, showing a connection to the entered address. The address that the Utility is connected to will also be shown on the screen.

6. The printer may now be used from the Utility.
Discovering Printers using a Subnet Search

7. Select the “Subnet Search” method and the range to search. There are several search possibilities

   192.168.1.* - Search the entire subnet
   192.168.1.5-68 - Search from “192.168.1.5 to “192.168.1.68”
   192.168.1.2 - Search for just “192.168.1.2”

8. For example, if you want the entire 10.3.5. subnet, enter “10.3.5.*” – this will cause the Utility to send a discovery message to each address in the indicated subnet.

9. Click “Discover” to start the search

10. Once the Search is complete, a list of discovered devices will be displayed. Select the desired device and click it to select it. The Utility will then begin the process of making a connection to the device.
11. The Utility will create a connection to the printer and query the printer to determine the printer's formatting language:

![Determining Printer Language](image)

12. Once the language has been determined, the name of the language will be displayed on-screen and the Utility will return to the home screen, showing a connection to the entered address. The address that the Utility is connected to will also be shown on the screen.

13. The printer may now be used from the Utility.
Manually connecting to a printer via a Network connection

1. Select “Network Manual”

![Image of network selection menu]

**NOTE:** If your network does not allow TCP communications over the port being used, the connection attempt will not be successful.
2. Enter the IP Address of the printer and Port Number to use and click “Connect”

3. The Utility will create a connection to the printer and query the printer to determine the printers formatting language:
4. Once the language has been determined, the name of the language will be displayed on-screen and the Utility will return to the home screen, showing a connection to the entered address.

The printer may now be used from the Utility.
Connecting to a previously used device

If a printer has been previously used, a connection can be quickly made to the device.

1. Select the device from the “Known Printers” list and click on it

2. The Utility will create a connection to the printer and query the printer to determine the printer's formatting language:
3. Once the language has been determined, the name of the language will be displayed on-screen and the Utility will return to the home screen, showing a connection to the entered address.

The printer may now be used from the Utility.
Retrieving a list of templates and selecting a document for printing

Once a connection has been made to a printer, it is possible to use the formats on the phone, or on the printer to print.

1. Once the main screen, select the “Print” icon

![Zebra Utilities screen with options for Find, Print, Manage, Options, and Demos. Status: No Printer Connection.](image)
2. When the “Get Formats” link appears, click it and the Utility will start retrieving formats from the currently connected printer and from the Windows Mobile device.

![Image of a list of available formats]

3. The list of available formats – both stored on the Windows Mobile device and on the printer, will be displayed. Formats stored on the phone will have a phone icon next to them and formats stored on the printer will have a printer icon next to them.

   Scroll down to the desired format and select it:

4. The Utility will retrieve the details on the format, including any prompts that are contained within the format
5. Once the prompts display, fill out the necessary data, enter a print quantity and click “Print”.

![Image of label printing interface]

**NOTE:** Not all printers support the presentation of Prompts. Printers using the CPCL language will display prompts as “Field 1”, “Field 2” and so on.

6. Your label will print:

![Image of printed label]

Acme Industries

Bob Jones

Sales
Printer Management from a Windows Mobile device

The ZebraLink Windows Mobile Utility has convenience features for managing your printer. This includes the following features:

- Printing a configuration label
- Resetting the printer
- Defaulting the printer
- Viewing Status
- Calibrating Media
- Sending commands

To access the Printer Management features of the Utility, select the “Manage” icon.
The “Manage Printer selection menu will display:

![Manage Printer selection menu](image)

**Printing a configuration label**

To print the printer’s configuration label, click the “Print Configuration” button when connected to a printer.

**Resetting a printer**

To reset a printer, click the “Reset Printer” button when connected to a printer. The printer will reset.

**Default a printer**

To default a printer, click the “Default Printer” button when connected to a printer. The printer will default. On ZPL printers, this action is equal to sending the ^XA^JUF^XZ command. On CPCL printers, this action is equal to resetting the LCD settings to their defaults.
**Viewing printer status**

To View Status, select the “View Status” button when connected to a printer. If you are not connected to a printer, the Utility will display an error message.

Different printers can display different status information. Printers using the ZPL language can display a range of status items, while printers using the CPCL language will display Media Out or Head Open status messages.

**Calibrate Media**

To confirm the media calibration, click the “Calibrate Media” button when connected to a printer. On ZPL printers, this action is equal to sending the ~JC command. On CPCL printers, this action is equal to feeding a label.

**Sending commands**

To send commands to the printer, enter the “Manage” menu and scroll down to the “Command” section. Enter up to 80 characters and click the “Send” button to transfer the content to the printer the Utility is connected to.

For example, sending the following to a printer that supports the command would increase the print speed by one setting:

! U1 setvar "media.speed" "up"

![Image of the Comm Window with text: ! U1 setvar "media.speed" "up"](image)

**Notes:** the “Command” text entry is subject to the standard Windows Mobile OS input guidelines for prompts. Also, the “Command” text entry prompt is not bi-directional; it will not display responses from the printer when commands that call for a response are used.
Option Settings on a Windows Mobile device

The ZebraLink Windows Mobile Utility has several option settings that enhance the flexibility of the software.

- Keep Found Printer History
- IP Search Range
- Retrieve Label location
- Default Printer language
- Label Directory
- Default printing port
- Auto Connect to printer

Keep Found Printer History

This feature controls the Utilities ability to keep a list of recently used printers. Check the box to activate the feature, uncheck it to deactivate the feature.

IP Search Range

This feature allows the user to set a pre-set IP address range to search for printers in when performing a Network Search. The Subnet can be entered in the following formats:

- 192.168.1.* - Search the entire subnet
- 192.168.1.5-68 - Search from “192.168.1.5 to “192.168.1.68”
- 192.168.1.2 - Search for just “192.168.1.2”

NOTE: do not put spaces in the search range – such as “192.168.1.5-68” – as opposed to “192.168.1.5-68”. Spaces will cause the Utility to search the entire subnet.

Retrieve Label location

This feature allows the user to control where the Utility will look for formats. The choices are

- On the printer
- On the phone (or terminal)
- Both on the printer and on the phone

The advantage of retrieving from fewer locations is that the retrieval process is faster. Additionally, Administrators may want to limit the users to using only formats stored on the phone so that label updates can be centralized and “pushed” out to devices as needed.
**Default Printer language**

This feature allows the user to set a default printer language to use. The advantage of setting a default language is that it removes one step from the process of connecting to a printer.

**Label Directory**

This feature allows the user to set a default directory for the Utility to search in for label formats.

**Default printing port**

This feature allows the user to set a default printing port to use over networked connections. For ZPL printers, the default port is normally 9100, for CPCL (mobile) printers, the default port is normally 6101. The advantage of using this feature is that it removes one step from the process of connecting to a printer.

**Auto Connect to printer**

This feature allows the user to configure the Utility to automatically attempt to make a connection to the last printer the Utility was used with. The advantage of using this feature is that it removes the need to search for printers from the process of connecting to a printer.
Demonstration Applications on a Windows Mobile device

Four demonstration applications are included within the ZebraLink Windows Mobile Utility. These allow you to quickly experience printing simulated Photo ID badges, Asset Tags, e-Citations and Name Badges. These demos are available from the main menu, by selecting the “Demos” icon.

Note: the demo apps will allow you to enter the app and fill out the forms, or select from the variable data lists without an active printer connection, however, if there is no printer connection an error message will be displayed when you click the “Print” button.
**Photo ID Badge**

The Photo ID Badge demo allow you to enter a First and Last name, take a picture and then have that information printed to a connected printer.

To use the demo, enter a First and Last name and click the “Print” button. The camera function on the phone will be access and you will be able to take a picture. The picture will be used to print a name Badge with a photo.

Note: If you device does not have a camera is used, the Photo ID Badge demo app will display an error message when you attempt to print.

Note: The “Picture Size” setting on your phone has a direct impact on image quality and print time. Higher settings will result in a better printed image, with slower throughput. The printed image quality is also directly impacted by the darkness and print speed settings on the printer, as well as by the resolution of the printer used (meaning a 600 dpi printer will deliver higher resolution images than a 203 dpi printer).
**Asset Tag**

The Asset Tag demo allows you to select from a list of pre-determined assets (hand tools) and then have a simulated data lookup occur.

To use the demo, select an Item from the list. A simulated data lookup will be performed. Once the simulated data lookup is complete, a picture of the asset will be displayed on-screen. The information can then be printed to a connected printer by clicking on the “Print” button.
Traffic Ticket

The Traffic Ticket demo allows you to print a simulated Traffic ticket, using variable data.

To use the demo, enter up to 10 alphanumeric characters to represent a License Plate number.

Then, after you select a violation from the “Violation Type” list. A simulated data lookup will be performed. Once the simulated data lookup is complete, details will be displayed.

The information can then be sent to a connected printer by clicking on the “Print” button.
**Name Badge**

The Traffic Ticket demo allows you to print a name badge, using variable data.

To use the demo, enter up to 20 alphanumeric characters for the “First Name” and “Last Name” fields. Click the “Print” button to print the Name Badge to a connected printer.
Storing Label Templates on a Windows Mobile

Label templates can be stored on the Windows Mobile device instead of on the printer. In the “Options” settings the user can define where label templates will be stored. By default, templates will be store in “\My Documents\labels” directory.

The “Label Directory” can be changed. Zebra recommends using a separate directory for label templates so that the user does not mistakenly try to send files to the printer that are not able to be processed. Additionally, using a unique “Label Directory” will make it less likely that a user will unintentionally send a printer configuration to the printer.

Label templates can be transferred to phones in two ways:

- Files sent attached to emails can be saved to the “Label Directory”.
- Files can be pushed to the “Label Directory” by system Administrators.

“Pushing” label templates from a centralized location; out to a user population is an efficient way to centrally manage label templates to ensure that users have the most current content.
Installing on a Windows Mobile device

Users can install the ZebraLink™ Windows Mobile Utility using one of two methods:

- ActiveSync
- Over the air, from www.zebra.com/sdk

Supported Windows Mobile® devices (using Windows Mobile 5.0 or later, also requires Microsoft® .NET Compact Framework v3.5 or higher):

- Motorola®/Symbol MC70xx
- Motorola/Symbol MC75
- Motorola/Symbol MC9090
- HTC® Touch
- HTC Diamond
- HTC Pure ST6356
- HP® iPAQ® 910 Business Messenger
- Samsung® Jack

Installing via ActiveSync

The “Explore” feature in ActiveSync can be used to install the ZebraLink™ Windows Mobile Utility. The installation files are included with the ZebraLink™ Multiplatform Software Development Kit, available for download at www.zebra.com/sdk.

The files needed to install the Utility are in the “zebra_utilities\release” directory – which by default is:

C:\Program Files\Zebra Technologies\zebralink_sdk\windows_mobile\v[version#]\zebra_utilities\release

Where [version#] is the version number of the Utility.
Once your Window Mobile device is connected and recognized by ActiveSync, Use the “Explore” button in ActiveSync to open an Explorer dialog showing your device. Drag the file “ZebraUtilities.CAB” to your Mobile device.

![ActiveSync](image1)

Then, disconnect your Mobile device from your PC and – on the Mobile device – navigate to the main directory, locate the “ZebraUtilities” file and select it to begin the installation process.

![File Explorer](image2)
The installation will take a few moments (depending on your device):

![Installing ZebraUtilities.CAB](image)

Once the installation is complete, you will see a confirmation that the process was successful:

![ZebraUtilities.CAB was successfully installed on your device](image)

If you need more storage space, you can remove installed programs.
**Installing over the air**

The ZebraLink™ Windows Mobile Utility can be downloaded and installed directly to your device from [www.zebra.com/sdk](http://www.zebra.com/sdk).

To install the Utility, from your supported BlackBerry® smartphone, browse to [www.zebra.com/sdk](http://www.zebra.com/sdk) and click on the “Download to your Windows Mobile device” link.

The web site will require you to accept an End User License Agreement (EULA). Click to Accept the EULA and begin the install.

The installation will take a few moments (depending on your device):
Once the installation is complete, you will see a confirmation that the process was successful:

ZebraUtilities.CAB was successfully installed on your device.

If you need more storage space, you can remove installed programs.
Printing from a BlackBerry® smartphone

Printing the “Example” label design from your phone is easy. There are three steps –

- Connect to the printer via Bluetooth or a network connection
- Retrieve the label design you want to print
- Fill in the Keyboard Prompts and click the “Print” button

Note: if you have not yet installed the ZebraLink SmartPhone Utility, see the section “Installing the ZebraLink SmartPhone Utility” later in this document.

Discovering and connecting to a printer

Printers can be discovered and communicated with via Bluetooth a network connection. There are several methods available, including:

- Manually Connecting to printers via Bluetooth
- Automatically locating printers via a Bluetooth connection
- Manually connecting to a printer via a Network connection
- Automatically locating printers on a Network connection
- Connecting to a previously known device

Click the “Find Printers” icon to begin the process:
Manually Connecting to printers via Bluetooth

1. To manually connect to a printer via Bluetooth, it is necessary to enter the Bluetooth MAC address of the printer. To obtain the Bluetooth MAC address, print the configuration page of the printer. The Bluetooth MAC address will be displayed in the “Bluetooth” section of the printer’s configuration label. For information on how to cause the configuration label to print, consult the printer’s User Guide.

A Bluetooth MAC address will consist of 12 Hexadecimal characters, normally represented on the printer’s configuration label in the following format:

00:03:7A:18:CA:48

2. Select “Manual” and click Search
3. Select “Bluetooth” and enter the printers Bluetooth MAC address. When entering the address, type in the Hexadecimal characters without the colon characters –

00037A18CA48

When entering a Bluetooth MAC address, the Utility will treat the Numeric value on the keyboard as the default character set to use, holding down the “alt” key will provide access to the Alpha characters. The Alpha characters will be entered as upper case characters.

4. When done entering the Bluetooth MAC Address of the printer, click “Connect to Printer”:

Note: If the Utility determines that the Bluetooth radio is off, you will be notified and asked to allow the radio to be turned on.
5. The Utility will create a connection to the printer and query the printer to determine the
printers formatting language:

6. Once the language has been determined, the name of the language will be displayed on-
screen and the Utility will return to the home screen, showing a connection to the entered
address. The address that the Utility is connected to will also be shown in the upper title bar
of each module, alternating with the name of the module.

The printer may now be used from the Utility.
Automatically locating printers via a Bluetooth connection

7. To automatically connect to a printer via Bluetooth, it is necessary for the Utility to search the local environment for Bluetooth devices. To use this method, select “Bluetooth” and click the “Search” button.

8. To begin the search, click the “Find Printers” button. During the search, all local Bluetooth devices will be found. Once the search is complete, a list of discovered devices will be displayed by their Bluetooth MAC addresses.
Note: If the Utility determines that the Bluetooth radio is off, you will be notified and asked to allow the radio to be turned on.

9. If your printer was discovered, it will be listed in the search results. If you do not know the Bluetooth MAC address of your printer, print the configuration page of the printer. The Bluetooth MAC address will be displayed in the “Bluetooth” section of the printer’s configuration label. For information on how to cause the configuration label to print, consult the printers User Guide.
10. To create a connection to your printer, scroll to the devices Bluetooth MAC address in the search results and click on the address.

11. The Utility will create a connection to the printer and query the printer to determine the printers formatting language:

12. Once the language has been determined, the name of the language will be displayed on-screen and the Utility will return to the home screen, showing a connection to the entered address. The address that the Utility is connected to will also be shown in the upper title bar of each module, alternating with the name of the module.

The printer may now be used from the Utility.
**Manually connecting to a printer via a Network connection**

1. Select “Manual” and click Search

![Select Search Method](image)

*NOTE:* If your network does not allow TCP communications over the port being used, the connection attempt will not be successful. Additionally, using a network connection to a printer over a cell phone infrastructure, such as a 3G network and a BES® or MDS® system, may result in slower throughput than thru a WLAN connection. Please note that on some systems, when a BES® or MDS® system is in place, the WLAN radio is not available.

2. Enter the IP Address of the printer and Port Number to use and click “Connect to Printer”

![Connect to a Printer](image)
3. The Utility will create a connection to the printer and query the printer to determine the printers formatting language:

4. Once the language has been determined, the name of the language will be displayed on-screen and the Utility will return to the home screen, showing a connection to the entered address. The address that the Utility is connected to will also be shown in the upper title bar of each module, alternating with the name of the module.

The printer may now be used from the Utility.
Automatic locating printers on a Network connection

1. Select “Network” and click “Search”

NOTE: This method uses UDP-based communications, over port 4201, to locate printers. If your network does not allow UDP communications over port 4201, the automatic discovery method will not work. Additionally, using the automatic discovery method over cell phone connections, such as a 3G connection may take a longer than over a WLAN connection.

NOTE: Phones that use BES® or MDS® system may not allow WLAN traffic.
2. Enter a Subnet to search within. The Subnet can be entered in the following formats:

- 192.168.1.* - Search the entire subnet
- 192.168.1.5-68 - Search from “192.168.1.5 to “192.168.1.68”
- 192.168.1.2 - Search for just “192.168.1.2”

**NOTE:** do not put spaces in the search range – such as “192.168.1.5- 68” – as opposed to “192.168.1.5-68”. Spaces will cause the Utility to search the entire subnet.

3. Click “Find Printer” to begin the Search. The Search will be performed and a list of results will display

4. Once the Search is complete, a list of discovered devices will be displayed. Select the desired device and click it to select it. The Utility will then begin the process of making a connection to the device.
5. The Utility will create a connection to the printer and query the printer to determine the printer's formatting language:

6. Once the language has been determined, the name of the language will be displayed on-screen and the Utility will return to the home screen, showing a connection to the entered address. The address that the Utility is connected to will also be shown in the upper title bar of each module, alternating with the name of the module.

The printer may now be used from the Utility.
Connecting to a previously known device

If a printer has been previously used, a connection can be quickly made to the device.

4. Select the device from the “Known Printers” list and click on it

5. The Utility will create a connection to the printer and query the printer to determine the printers formatting language:

6. Once the language has been determined, the name of the language will be displayed on-screen and the Utility will return to the home screen, showing a connection to the entered address. The address that the Utility is connected to will also be shown in the upper title bar of each module, alternating with the name of the module.

The printer may now be used from the Utility.
Retrieving a list of templates and selecting a document for printing

Once a connection has been made to a printer, it is possible to use the formats on the phone, or on the printer to print.

7. Once the main screen, select the “Print” icon”

8. When the “Get Formats” button appears, click it and the Utility will start retrieving formats from the currently connected printer and from the phone.
9. The list of available formats – both stored on the phone and on the printer, will be displayed. Formats stored on the phone will have a phone icon next to them and formats stored on the printer will have a printer icon next to them.

Scroll down to the “EXAMPLE.ZPL” format and click it:

10. The Utility will retrieve the details on the format, including any prompts that are contained within the format.
11. Once the prompts display, fill out the necessary data, enter a print quantity and click print.

![Format Name: E:EXAMPLE.ZPL](image)

<table>
<thead>
<tr>
<th>Variable Fields:</th>
</tr>
</thead>
<tbody>
<tr>
<td>First Name : Bob</td>
</tr>
<tr>
<td>Last Name : Jones</td>
</tr>
<tr>
<td>Department : Sales</td>
</tr>
<tr>
<td>Print Quantity: 1</td>
</tr>
</tbody>
</table>

**NOTE:** Not all printers support the presentation of Prompts. Printers using the CPCL language will display prompts as “Field 1”, “Field 2” and so on.

12. Your label will print:

```
Acme Industries

Bob
Jones

Sales
```
Printer Management from a BlackBerry® smartphone

The ZebraLink Smart Phone Utility has convenience features for managing your printer. This includes the following features:

- Viewing Status
- Printing a configuration label
- Resetting the printer
- Defaulting the printer
- Calibrating Media
- Sending commands

Viewing printer status

To View Status, select the “View Status” button when connected to a printer. If you are not connected to a printer, the Utility will display an error message.
Different printers can display different status information. Printers using the ZPL language can display a range of status items, while printers using the CPCL language will display Media Out or Head Open status messages.

Here, a ZPL printer is being used, showing two status messages. Clicking the “Refresh” button will update the status information.

### Printing a configuration label

To print the printer’s configuration label, enter the “Tools” menu and click the “Print Configuration” button when connected to a printer.
**Resetting a printer**

To reset a printer, enter the “Tools” menu and click the “Reset Printer” button when connected to a printer. The printer will reset.

**Default a printer**

To default a printer, enter the “Tools” menu and click the “Default Printer” button when connected to a printer. The printer will default. On ZPL printers, this action is equal to sending the ^XA^JUF^XZ command. On CPCL printers, this action is equal to resetting the LCD settings to their defaults.

**Calibrate Media**

To confirm the media calibration, enter the “Tools” menu and click the “Calibrate Media” button when connected to a printer. On ZPL printers, this action is equal to sending the ~JC command. On CPCL printers, this action is equal to feeding a label.

**Sending commands**

To send commands to the printer, enter the “Tools” menu and scroll down to the “Command” section. Enter up to 80 characters and click the “Send” button to transfer the content to the printer the Utility is connected to.

For example, sending the following to a printer that supports the command would increase the print speed by one setting:

```plaintext
! U1 setvar "media.speed" "up"
```

**Note:** the “Command” text entry is subject to the standard BlackBerry OS input guidelines for prompts.

**Note:** the “Command” text entry prompt is not bi-directional; it will not display responses from the printer when commands that call for a response are used.
Option Settings on a BlackBerry® smartphone

The ZebraLink Smart Phone Utility has several option settings that enhance the flexibility of the software.

- Keep Found Printer History
- IP Search Range
- Retrieve Label location
- Default Printer language
- Label Directory
- Default printing port
- Auto Connect to printer

Keep Found Printer History

This feature controls the Utility’s ability to keep a list of recently used printers. Click “Yes” to have the Utility maintain a list; click “No” to stop maintaining the list. Click “Clear History” to delete the currently maintained list.

IP Search Range

This feature allows the user to set a pre-set IP address range to search for printers in when performing a Network Search. The Subnet can be entered in the following formats:

- 192.168.1.* - Search the entire subnet
- 192.168.1.5-68 - Search from “192.168.1.5 to “192.168.1.68”
- 192.168.1.2 - Search for just “192.168.1.2”

NOTE: do not put spaces in the search range – such as “192.168.1.5- 68” – as opposed to “192.168.1.5-68”. Spaces will cause the Utility to search the entire subnet.

Retrieve Label location

This feature allows the user to control where the Utility will look for formats. The choices are

- On the printer
- On the phone
- Both on the printer and on the phone

The advantage of retrieving from fewer locations is that the retrieval process is faster. Additionally, Administrators may want to limit the users to using only formats stored on the phone so that label updates can be centralized and “pushed” out to devices as needed.
**Default Printer language**

This feature allows the user to set a default printer language to use. The advantage of setting a default language is that it removes one step from the process of connecting to a printer.

**Label Directory**

This feature allows the user to set a default directory for the Utility to search in for label formats. See the section on “Storing Label Templates on a BlackBerry® smartphone” for more information.

**Default printing port**

This feature allows the user to set a default printing port to use over networked connections. For ZPL printers, the default port is normally 9100, for CPCL (mobile) printers, the default port is normally 6101. The advantage of using this feature is that it removes one step from the process of connecting to a printer.

**Auto Connect to printer**

This feature allows the user to configure the Utility to automatically attempt to make a connection to the last printer the Utility was used with. The advantage of using this feature is that it removes the need to search for printers from the process of connecting to a printer.
Demonstration Applications on a BlackBerry® smartphone

Four demonstration applications are included within the ZebraLink Smart Phone Utility. These allow you to quickly experience printing simulated Photo ID badges, Asset Tags, e-Citations and Name Badges. These demos are available from the main menu, by selecting the “Demos” icon.

Note: the demo apps will allow you to enter the app and fill out the forms, or select from the variable data lists without an active printer connection, however, if there is no printer connection an error message will be displayed when you click the “Print” button.
**Photo ID Badge**

The Photo ID Badge demo allow you to enter a First and Last name, take a picture and then have that information printed to a connected printer.

To use the demo, enter a First and Last name and click the “Print Badge” button. The camera function on the phone will be access and you will be able to take a picture. The picture will be used to print a name Badge with a photo.

![Photo ID Badge Demo](image)

**Note:** If a phone that does not have a camera is used, the Photo ID Badge demo app will display an error message when you attempt to print.

**Note:** The “Picture Size” setting on your phone has a direct impact on image quality and print time. Higher settings will result in a better printed image, with slower throughput. The printed image quality is also directly impacted by the darkness and print speed settings on the printer, as well as by the resolution of the printer used (meaning a 600 dpi printer will deliver higher resolution images than a 203 dpi printer).
**Asset Tag**

The Asset Tag demo allows you to select from a list of pre-determined assets (hand tools) and then have a simulated data lookup occur.

To use the demo, select an Item from the list. A simulated data lookup will be performed. Once the simulated data lookup is complete, a picture of the asset will be displayed on-screen. The information can then be printed to a connected printer by clicking on the “Print” button.
**Traffic Ticket**

The Traffic Ticket demo allows you to print a simulated Traffic ticket, using variable data.

To use the demo, enter up to 10 alphanumeric characters to represent a License Plate number.

Then, scroll down to select a violation from the “Violation Type” list. Click on the “Get Data” button to perform a simulated data lookup on the entered information.

Once the simulated data lookup is complete, details will be displayed.

The information can then be sent to a connected printer by clicking on the “Print” button.
**Name Badge**

The Traffic Ticket demo allows you to print a name Badge, using variable data.

To use the demo, enter up to 20 alphanumeric characters for the “First Name” and “Last Name fields. Clicking the “Print” button to print the Name Badge to a connected printer.
Storing Label Templates on a BlackBerry® smartphone

Label templates can be stored on the phone instead of on the printer. In the “Options” settings the user can define where label templates will be stored. By default, templates will be store in “/store/home/user/documents/” directory.

The “Label Directory” can be changed. Zebra recommends using a separate directory for label templates so that the user does not mistakenly try to send files to the printer that are not able to be processed. Additionally, creating a unique “Label Directory” will make it less likely that a user will unintentionally send a printer configuration to the printer.

Label templates can be transferred to phones in two ways:

- Files sent attached to emails can be saved to the “Label Directory”
- Files can be pushed to the “Label Directory” by system Administrators using the existing BlackBerry “Push” infrastructure. Consult with your system Administrators for more information.

“Pushing” label templates from a centralized location; out to a user population is an efficient way to centrally manage label templates to ensure that users have the most current content.
Installing on a BlackBerry® smartphone

Users can install the ZebraLink™ Smart Phone Utility using one of two methods:

- The BlackBerry® Desktop Manager
- Over the air, from www.zebra.com/sdk

The following devices are supported:

Supported BlackBerry smartphone devices (using OS 4.2.1 or later)

- 8100 Pearl™ Series
- Pearl™ Flip Series
- Curve™ 8300, 8520, 8900 Series
- 8800 Series
- Bold™ 9000
- Tour™ 9630

Note: If your device does not have the minimum Operating System noted above, consult your Administrator to have your device updated. The BlackBerry® Desktop Manager can be used to update the Operating System software for your device; however, this should be done in consultation with your system Administrator.

Installing via the BlackBerry® Desktop Manager

The “Application Loader” in the BlackBerry® Desktop Manager can be used to install the ZebraLink™ SmartPhone Utility. The installation files are included with the ZebraLink™ Multiplatform Software Development Kit, available for download at www.zebra.com/sdk.

The files needed to install the Utility are in the “desktop_deployment” directory – which by default is:

C:\Program Files\Zebra Technologies\zebralink_sdk\blackberry\[version#]\zebra_utilities\release\desktop_deployment

Where [version#] is the version number of the Utility.

Use the BlackBerry® Desktop Manager to locate and install the ZebraLink™ Smart Phone Utility to your device. Consult with your Administrators for full details and assistance with using the BlackBerry® Desktop Manager.

Note: Zebra recommends using the latest version of the BlackBerry® Desktop Manager.
Installing over the air

The ZebraLink™ Smart Phone Utility can be downloaded and installed directly to your BlackBerry® smartphone from [www.zebra.com/sdk](http://www.zebra.com/sdk).

To install the Utility, from your supported BlackBerry® smartphone, browse to [www.zebra.com/sdk](http://www.zebra.com/sdk) and click on the “Download to your Blackberry smartphone” link.

The web site will require you to accept an End User License Agreement (EULA). Click to Accept the EULA and begin the install.

At the beginning of the installation, you will be asked to confirm that you want to install the Utility, Click “**Download**” to continue with the installation.

```
Name: Zebra Utilities
Version: 1.0.37
Vendor: Zebra Technologies Corporation
Size: 325.0KB
Description: Printing Utility
```

![Download dialog box](image-url)
During the installation, a progress bar will be displayed as the Utility is downloaded and installed. Depending on the speed of the phones connection to the network, this can take a few minutes.

During the end of the installation, a message will display, showing that the application was successfully installed. Click “Run” to run the applications.

**Note:** When you first run the Utility, you may be asked to set the permissions for the Utility. See the section on “Setting Permissions on a BlackBerry® smartphone” to details on this process.
Setting Permissions on a BlackBerry® smartphone

The first time you launch the ZebraLink Smart Phone Utility application it will check the permissions for the application.

If they are incorrect, the ZebraLink Smart Phone Utility will attempt to set the correct value for each permission setting. You will be notified that this is being done and you will have an option to save or modified those settings before continuing with the execution of the ZebraLink Smart Phone Utility. If the following permissions are not set to Allow the application may exhibit incorrect behavior and will likely not allow you to perform many of the operations within the application. Depending upon the setting that is incorrectly set, it is possible that the application may hang, only to be recovered by resetting the phone.

Permissions which must be set to “Allow”

- Bluetooth
- Carrier Internet (Internet)
- Company Network (Server Network)
- Keystroke Injection (Input Simulation)
- Interprocess Communication (Cross Application Communication)
- Files
- Wi-Fi

Steps to Configure Permissions for the ZebraLink Smart Phone Utility

Setting the permissions for the ZebraLink Smart Phone Utility varies per phone model and platform version, so please review your product's documentation for the correct procedure. The following procedure is for a BlackBerry® Curve™ smartphone (running Operating System v4.6.1.231).

1. From the main screen click on the Menu key
2. Navigate to the Options screen
3. Select 'Applications'

4. Select 'Advanced Options'
5. Navigate to 'Zebra Utilities'

6. Click the Menu key
7. Select 'Edit Permissions'
8. For each of the above permissions required, change the option to 'Allow'. The list is:

- Bluetooth
- Carrier Internet (Internet)
- Company Network (Server Network)
- Keystroke Injection (Input Simulation)
- Interprocess Communication (Cross Application Communication)
- Files
- Wi-Fi

1. To set an entire branch or an item, click on it and select 'Allow':
2. Click on the **Menu** key
3. Select *Save*
4. Click on the **escape** key to exit
Technical Support

Online Support

You can find the latest builds and updates on the Zebra Web site – [www.zebra.com/sdk](http://www.zebra.com/sdk)

If you cannot resolve the issue, please contact your local reseller or the offices listed in the topic

Contact Information

Worldwide, Technical Support is available through your Reseller, or at: [http://www.zebra.com/support](http://www.zebra.com/support).

Professional Programming Services can be obtained by contacting sdk@zebra.com. Service Quotations available upon request.

Zebra Technologies Corporation
333 Corporate Woods Parkway
Vernon Hills, Illinois 60061.3109 U.S.A.
Telephone: +1 847.793.2600
Facsimile: +1 847.913.8766

EMEA Headquarters & Sales Office
Zebra Technologies Europe Limited
Dukes Meadow
Millboard Road
Bourne End
Buckinghamshire SL8 5XF, UK
Telephone: +44 (0) 1628 556000
Facsimile: +44 (0) 1628 556001

Zebra Technologies Asia Pacific Pte. Ltd.
120 Robinson Road
#06-01 Parakou Building
Singapore 068913
Phone: +65 6858 0722
Fax: +65 6885 0838 SPS
+ 65 6885 0836 CPS